
 

Release Notes for 
Campus Manager 4.0.3 on Solaris

These release notes are for use with the Campus Manager 4.0.3, part of the 
CiscoWorks family of products running on a Solaris platform. Supported Solaris 
versions are Solaris 8 (Solaris 2.8) and Solaris 9 (Solaris 2.9).

These release notes provide: 

• New Features, page 2

• Product Documentation, page 6

• Related Documentation, page 8

• Additional Information Online, page 8

• Support Information, page 9

• Known Problems, page 9

• Resolved Problems, page 55

• Obtaining Documentation, page 64

• Documentation Feedback, page 65

• Obtaining Technical Assistance, page 67

• Obtaining Additional Publications and Information, page 69
Corporate Headquarters: 

© 2005 Cisco Systems, Inc. All rights reserved.

Cisco Systems, Inc., 170 West Tasman Drive, San Jose, CA 95134-1706 USA



 

New Features
New Features
This section contains the changes and enhancements in Campus Manager 4.0.3:

• Re-Factoring of Campus Manager Server Process, page 2

• Improved Network Discovery, page 3

• Improved Data Collection, page 3

• Support for SNMPv3, page 3

• Support for IPv6, page 3

• Support for VLAN and VTP, page 4

• Support for Spanning Tree Protocols, page 4

• Support for Configuration of Ether Channel and Inter-VLAN Routing, page 5

• Support for Trunking, page 5

• Support for TDR, page 5

• HTML Based User Interface, page 5

• Integration with Common Services 3.0.3 Components, page 5

Re-Factoring of Campus Manager Server Process
The Campus Manager server has been refactored to improve the performance and 
scalability of the application.

Before Campus Manager 4.0, the Campus Manager server process was a single 
process to perform Device Discovery, user tracking, servicing query and 
configuration from clients.

To improve the server performance and to handle larger networks, 
Campus Manager server process has been separated into transient processes for 
device discovery and User Tracking Major Acquisition.
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New Features
Campus Manager 4.0.3 contains:

• Campus Manager server process as a daemon

• Transient Device Discovery process

• Transient User Tracking Major acquisition process

Data collection, query and configuration services continue to be performed in the 
Campus Manager server process.

Improved Network Discovery
With Campus Manager 4.0.3, you can:

• Provide seed devices. 

• Set the SNMP credentials.

• Run device discovery. 

Device Discovery process discovers devices and updates the Device 
Credential Repository (DCR) with the credentials of the devices.

Note Campus Manager cannot manage the devices until you run the Data 
collection process.

Improved Data Collection
You can choose devices to be managed by Campus Manager from the devices in 
DCR, or through data collection filters (IP subnets or VTP domains).

Support for SNMPv3
Campus Manager discovers devices configured with SNMPv3 credentials.

Support for IPv6
Campus Manager can discover IPv6, manage IPv4, and dual stack IPv6 devices. 
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New Features
Support for VLAN and VTP
With Campus Manager 4.0.3, you can:

• Create a primary VLAN, secondary VLANs of different types and associate 
them to the primary VLAN, assign or move ports to secondary VLANs, and 
configure Promiscuous ports. 

• Verify the VTPv2 or VTPv3 related information for the devices in your 
network that are managed by Campus Manager. 

• Apply VTP server filter, transparent filter, or client filter for VTPv2 or 
VTPv3 domains in Topology Maps. 

Support for Spanning Tree Protocols
Campus Manager 4.0.3 provides support for Spanning Tree Protocol. Along with 
support for different types of Spanning Tree Protocol (STP)—PVST, PVST+, 
MST, MISTP, it allows you to:

• View STP parameters for each switch-cloud, VLAN or instance, or for each 
port. 

• Configure STP parameters on a each port and each device.

• View and change the instance-to-VLAN mapping (for MST and MISTP).

• Configure preferred VLANs on trunk ports.

• Find the recommended optimal root for a switch cloud and highlights the 
computed Optimal Root (switch) on topology map.

• Find the recommendation for setting up the number of STP instances on a 
switch cloud. Highlights the recommended instances on the Map.

• Find the recommendation for reduction of number of STP instances.

• Highlight the instance to which the other instances can be merged.

• Map a new VLAN to recommended instance.

• Highlight the instance on the Map.

• Change certain STP parameters and view the result prior to applying the 
changes in the network.
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New Features
Support for Configuration of Ether Channel and 
Inter-VLAN Routing

Campus Manager 4.0.3 provides the following support for EtherChannels:

• Configuring multiple links between switches as EtherChannel.

• Configuring EtherChannel load balancing parameters.

Support for Trunking
Campus Manager 4.0.3 supports the following trunking features:

• Configuring a link between two switches as a trunk.

• Configuring the allowed and disallowed VLANs on a trunk.

Support for TDR
Campus Manager 4.0.3 provides support for Cable Diagnostic Test using 
Time Domain Reflectometry (TDR).

HTML Based User Interface
Campus Manager 4.0.3 has a non-Java based user interface for User Tracking 
application and Campus Manager Administration.

Integration with Common Services 3.0.3 Components
Campus Manager 4.0.3 integrates with Common Services 3.0.3 modules like 
OGS, UII, Security and ACS, DCR, PSU, and CiscoWorks Homepage.
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Product Documentation
Product Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

Table 1 describes the product documentation that is available.

Table 1 Product Documentation

Document Title Available Formats

Quick Start Guide for LAN 
Management Solution 2.5.1

• Printed document that was included with the product.

• On Cisco.com at:
http://www.cisco.com/en/US/products/sw/cscowork/ps2425/
prod_installation_guides_list.html

Data Migration Guide for 
LMS 2.5.1

• Printed document that was included with the product.

• On Cisco.com at this URL:

http://www.cisco.com/en/US/products/sw/cscowork/ps2425/
prod_installation_guides_list.html

User Guide for 
Campus Manager 4.0.3

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_user_guide_list.html

• Printed document available by order (part number 
DOC-7817186=).1

Supported Devices Table for 
Campus Manager 4.0.3

On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_device_support_tables_list.html
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Product Documentation
Installation and Setup Guide for 
Campus Manager 4.0.3 on Solaris

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
prod_installation_guides_list.html

• Printed document available by order (part number 
DOC-7817187=).1

User Guide for 
Campus Manager 4.0.3

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_user_guide_list.html

• Printed document available by order (part number 
DOC-7817186=).1

Supported Devices Table for 
Campus Manager 4.0.3

On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_device_support_tables_list.html

Context-sensitive Online help • Select an option from the navigation tree, then click Help.

• Click the Help button in the dialog box.

1. See the “Obtaining Documentation” section on page 64.

Table 1 Product Documentation (continued)

Document Title Available Formats
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Related Documentation
Related Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

Table 2 describes the additional documentation that is available.

Additional Information Online
The following product specific information is available online:

Service Packs (SP) contain updated files necessary for the latest device support 
and fixes to known problems that are not available in Campus Manager 4.0.3. If 
you are a registered user, you can download SP for Campus Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Table 2 Related Documentation

Document Title Description and Available Formats

User Guide for CiscoWorks 
Common Services 3.0.3

Describes CiscoWorks Common Services, gives an overview of 
the applications that make up Common Services 3.0.3 and 
provides conceptual information about network management.

This also describes common tasks you can accomplish with 
Common Services. This document is available in the following 
formats:

• PDF on the product CD-ROM.

• On Cisco.com at:
http://www.cisco.com/en/US/products/sw/cscowork/ps3996/
products_user_guide_list.html

• Printed document available by order (part number 
DOC-7817182=).1

1. See the “Obtaining Documentation” section on page 64.
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Support Information
Support Information
Campus Manager 4.0.3 supports only US-English and Japanese versions of 
Solaris Operating Systems. It does not support any other language version. Set the 
default locale to US-English for US-English version and Japanese for Japanese 
version.

Known Problems
This section describes the known problems in this release:

• General Notes and Known Problems, page 10

• General Known Problems, page 11

• Browser Known Problems, page 20

• Path Analysis Known Problems, page 21

• User Tracking Known Problems, page 27

• Topology Services Known Problems, page 33

• ANI Server Known Problems, page 47

• VLAN Port Assignment Known Problems, page 52

• Spanning Tree Protocol Known Problems, page 54

Note To obtain more information about known problems, access the Cisco Software 
Bug Toolkit at http://www.cisco.com/cgi-bin/Support/Bugtool/home.pl 
(You will be prompted to log into Cisco.com)
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Known Problems
General Notes and Known Problems
Note the following:

• Your browser must be properly configured. If it is not properly configured, 
Campus Manager might not work correctly. For more details, see the 
Installation and Setup Guide for Campus Manager 4.0.3 .

• Campus Manager requires a DNS server to function properly. Many 
commands operate erratically or not at all, if there is no DNS server on the 
network.

• You cannot run Campus Manager from a browser invoked from an X-Window 
System since this is not supported. Install a browser on the client from which 
you wish to connect.

• You can upgrade your operating system (OS) either before or after you 
upgrade Campus Manager. However, if you upgrade the OS after upgrading 
Campus Manager, you will not receive any OS-related patch warnings or 
service pack-related warnings.

• Verify that the latest version of all required OS patches, service packs, and 
third-party device drivers are installed before proceeding with an OS 
upgrade.

• Visio caveats:

– Do not export an entire topology map to Visio. Instead, select and export 
particular devices or a segment of the network.

– After selecting Export to Visio, you must enter a filename in the Export 
to Visio dialog box for the file that Visio will generate.

– Before opening a topology map exported to Visio, you must download 
the cm_cisco.vss file and place it in the Visio/Solutions directory.
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Known Problems
General Known Problems
The table below lists the known problems that are not specific to any module in 
Campus Manager.

Table 3 General Known Problems

Bug ID Summary Explanation

CSCsc49501 VeriSign security certificate 
displays expiry warning 
message.

The VeriSign security certificate expires in June 
2006. After that date, Campus Manager will 
display the Certificate expiry message whenever 
you launch applet based pages. 

However, all modules in Campus Manager will 
continue to work.

Workaround:

Ignore the message.

CSCsb86066 Topology and Path Analysis do 
not launch when NAT or firewall 
are configured.

If Campus Manager is installed in a server with 
NAT or firewall, Topology and Path Analysis do 
not launch. The following message appears:

Cant connect to ANI Sever

Workaround:

If you enable the ports supported by 
Common Services, Topology and Path Analysis 
work in a firewall setup. 

For details on these ports, see Installation and 
Setup Guide for CiscoWorks 
Common Services 3.0.3 (Includes CiscoView) on 
Solaris.
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Known Problems
CSCsc24255 Improper error message while 
configuring IVR.

This problem occurs in the following scenario:

If you do not give proper SNMP or Telnet 
credentials for a device in DCR, RME does not 
fetch Config details from that device. 

When you try to configure IVR for that device in 
Campus Manager, the following error message 
appears:

Failed in export/Import config.

Workaround:

Enter proper SNMP and Telnet credentials for the 
device in DCR.

CSCsb28190 Campus Manager applications 
do not start in ACS mode.

Topology Services, Path Analysis, VLAN Port 
Assignment, and Discrepancy Report tasks fail to 
start when you login to CiscoWorks in ACS mode. 

This problem occurs if you select Assign a 
Ciscoworks on a per Network Device Group 
Basis option in ACS server, but in the selected 
device group, you do not add the CiscoWorks 
server IP address.

Workaround:

When you assign a user to a specific group, ensure 
that you add the CiscoWorks Server IP address to 
that device group.

CSCsa80727 Sometimes, launching of 
Campus Manager UIs fails.

Campus Manager UIs fail to open when the 
daemon manager is not restarted for a long period 
of time.

Workaround:

1. Stop the daemon manager. 

2. Wait for 10 minutes and start the daemon 
manager.

Campus Manager UIs now open properly.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCsa44629 Campus Manager does not 
restore Topology Map settings 
after taking back up and restore 
in another machine, that has 
Campus Manager 4.0.

Campus Manager does not save the changes to 
layout style and background colors in Topology 
Map settings, that were backed up in another 
machine.

This occurs when you:

1. Modify Topology Map settings in a machine 
with Campus Manager 3.3.

1. Back up and restore the files in another 
machine, which has Campus Manager 4.0.

2. Run Data Collection.

3. Start Topology Services.

Workaround:

1. Run 
NMSROOT/campus/conf/upgrade/cm/topo/
2cm31maplayout.pl on the machine with 
Campus Manager 3.3 to generate the map 
files.

2. Copy the map files to the location on the target 
system, where you have restored the data: 
NMSROOT/campus/etc/users/username/

3. Upgrade Topology Map by selecting 
File > Upgrade View Layouts from Topology 
Services.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCsa22708 Campus Manager does not 
manage existing devices when 
upgrading from higher device 
limit to lower device limit.

This problem occurs because Campus Manager 
performs a fresh discovery of the network to 
obtain the devices and does not import them from 
the earlier versions.

Workaround:

None.

CSCin43133 Install may fail because of 
improper mount of CD-ROM.

Using Volume Management, vold mounts the 
CD-ROM as /cdrom/cdrom0. cdrom0 is a link to 
volume label of the CD-ROM. 

For example cm4.0.

In normal circumstances, the link gets cleared 
after the CD-ROM is ejected. However, if the link 
is not cleared, when you mount another CD-ROM, 
it is mounted as /cdrom/cdrom0, This is then 
linked to cm4.0#1.

This # character causes problem during 
installation.

To verify if the directory name has a # character 
appended to its name, navigate to the 
/cdrom/cdrom0 directory, and check the present 
working directory using pwd command.

Workaround:

1. Eject the CD-ROM.

2. Stop the vold:

/etc/volmgt stop

3. Start the vold:

/etc/volmgt start

4. Delete the contents of /cdrom0 directory.

The CD-ROM should now mount normally.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCin23883 Jobs created in Path Analysis or 
User Tracking appear in the Job 
Management page even after 
uninstalling Campus Manager.

If you have scheduled Path Analysis or User 
Tracking jobs and then uninstall Campus 
Manager, the jobs are not deleted from the 
CiscoWorks Job Management page.

Workaround;

Delete the Path Analysis or User Tracking jobs 
from the Job Management page.

CSCdu51651 You cannot select the first 
template from the drop-down 
box, when you create 
SPVC/SPVP/Advanced 
parameters.

Under ATM if you create SPVC/SPVP/Advanced 
parameters, you cannot select the first template 
from the drop-down box. This is because the 
traffic parameter fields are not populated.

Workarounds:

1. Go to Select/Edit and select the template.

2. Click OK.

Or

1. Select the second template

2. Select the first template.

CSCdt55303 Starting Campus Manager 
application with the Print dialog 
box open in another 
Campus Manager application 
results in an error.

This problem occurs if you:

1. Select Print from active Campus Manager 
application.

2. Start another Campus Manager application, 
with the Print dialog box open.

The new application window does not respond 
to user input.

Workaround:

Close the Print dialog box and restart the 
application.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdt42318 Cannot copy and paste IP 
addresses from Topology 
Services to Path Analysis when 
you use keyboard shortcuts.

This problem occurs if you:

• Enter Ctrl-C to copy address after selecting 
an IP address in Topology Services,

Or 

• Enter Ctrl-V with the cursor active in the 
From field in Path Analysis.

• In both cases the following is pasted in instead 
of the IP address:

java.lang.nullPointerException

Ctrl-X, Ctrl-C, and Ctrl-V (keyboard shortcuts for 
cut, copy, and paste commands) are not supported 
by summary tables in the Topology Services main 
window or most tables that are displayed by 
Campus Manager applications.

Also, in applications that support the copying of 
table cells by selecting Edit > Copy, a carriage 
return is added to the end of the last cell copied.

Workaround:

None.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
16
Release Notes for Campus Manager 4.0.3 on Solaris

78-17189-01



 

Known Problems
CSCdt22462 Download of Java applets on 
Windows 2000 machines may 
take longer than expected if virus 
checker application is enabled.

On some Windows systems, the initial download 
of large Java applets (or subsequent downloads of 
the same applets that are not cached locally) might 
take longer than expected (up to six minutes in 
some instances). 

After the applet has been loaded and cached 
locally, the problem no longer occurs.

The delay is caused by client side filtering 
mechanisms such as virus scanning. Some virus 
scanners are configured to automatically scan 
content downloaded by browsers. Scanning 
consumes a lot of memory and results in disk 
paging on most systems.

Hence, downloading is significantly slower than 
expected. The effect is less on systems with large 
amounts of RAM and virtual memory.

Workaround:

Disable the automatic scanning of all downloaded 
files, and instead enable the scanning of program 
files only (specified by file extension).

Exact instructions vary depending on the virus 
scanner installed on your system.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCds88388 Cannot launch CiscoView on an 
IGX series device.

This occurs if you:

1. Launch Topology Services.

2. Open LAN Edge view.

3. Right-click on IGX series device and select 
CiscoView from the Context menu.

A dialog box appears. 

4. Enter appropriate community strings, and 
CiscoView attempts to launch. 

An error message appears.

Workaround:

Launch CiscoView on IGX series devices via 
Cisco WAN Manager.

CSCdm88520 Minimized windows are not 
visible when you select them 
from a Window menu.

If a window is minimized, you cannot make it 
visible by selecting it from a Window menu. 

Workaround: 

Double-click the icon of the window on the 
taskbar.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdm8320 Campus Manager applications 
do not work when you access 
CiscoWorks using 
http://localhost:1741

If you access CiscoWorks applications using 
http://localhost:1741 from a browser on the 
same machine that CiscoWorks server is installed 
on, Campus Manager suite of applications will not 
work.

Workaround:

Use full DNS name or IP address of server, even 
when accessing it locally.

CSCdm77812 In Path Analysis, Tools > Path 
Trace displays an error,
null pointer exception on 
Microsoft Internet Explorer 5.0 
with the URL of a local host.

If your system has a non-blank CLASSPATH 
environment variable, your browser might behave 
unpredictably.

Workaround:

Reset the CLASSPATH variable non-globally:

• Solaris— Reset the CLASSPATH variable 
from the terminal window from where you 
launch the browser.

• Windows—Reset the CLASSPATH variable in 
MS-DOS prompt window and launch the 
browser from the prompt.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
Browser Known Problems
The table below lists the browser related known problems existing in 
Campus Manager.

Table 4 Browser Known Problems

Bug ID Summary Explanation

CSCin39472 Problems with Campus Manager 
applications after logout.

When you logout from CiscoWorks, 
Campus Manager applications will continue to 
function. However, the following functions will 
not be available:

• Launching Help.

• Tasks in Campus Manager which require user 
action between applications. For example, 
highlighting a device in Topology Services 
using Path Analysis.

Workaround:

1. Close all Campus Manager applications.

2. Login into CiscoWorks.

3. Launch Campus Manager applications.

CSCdt11838 You are not prompted to install 
the Java plug-in when launching 
an application that utilizes the 
plug-in for the first time.

If RealJukebox Plug-in for Navigator is already 
installed on a Windows client before the first 
launch of application utilizing Java Plug-in, you 
are not prompted to install Java Plug-in.

Workaround:

Uninstall RealJukebox Plug-in. Another option is 
to rename nprjplug.dll file in Navigator Plug-ins 
directory with new extension. For example, 
nprjplug.dll.bak.

After Java Plug-in is installed, you can reactivate 
RealJukebox Plug-in by changing the renamed file 
back to nprjplug.dll.
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Known Problems
Path Analysis Known Problems
The table below lists the Path Analysis related known problems existing in 
Campus Manager.

CSCdp43999 Maps and configuration dialogs 
display offset menus and list 
boxes in Netscape on a Solaris 
client.

Sometimes, when you launch a map or a 
configuration dialog box, menus or list boxes are 
not displayed below the menu. This offset occurs 
in Navigator on a Solaris client.

Workaround:

Move or resize window.

Table 4 Browser Known Problems (continued)

Bug ID Summary Explanation

Table 5 Path Analysis Known Problems

Bug ID Summary Explanation

CSCsa47939 You cannot start CiscoView from 
Path Analysis, on SSL server.

You cannot start CiscoView from Path Analysis 
because of an incorrect URL: 

https://CiscoWorksServer:-1/CVng/
chassis.do?deviceip=10.77.209.53

Workaround:

Replace -1 with 443 in the URL, thus correcting 
the URL to:

https://CiscoWorksServer:443/CVng/
chassis.do?deviceip=10.77.209.53
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Known Problems
CSCsa22380 Layer 2 Path Trace is not seen 
between IPv6 End host as source 
and its first hop IPv6 router.

In Path Analysis, when you run a Path Trace using 
IPv6 address of the End host and some other IPv6 
destination (say router), Layer 3 Trace is 
observed. 

However, Layer 2 Trace (switches if any) between 
End host and First hop router is not shown in Path 
Trace.

Workaround:

None.

CSCin37960 VLAN-to-Subnet mapping 
information is not available for 
Phone Traces.

Path Analysis does not provide VLAN-to-Subnet 
mapping information, when you run Path Trace 
between two IP phones.

Workaround:

None.

CSCin37938 Interface Type displays Unknown 
for phones in Path Analysis 
Table.

This problem occurs when you run Path Traces 
between IP Phones or between a device and IP 
Phone.

Workaround:

None.

CSCin36082 Additional hop appears when 
you perform a trace using HSRP 
virtual IP address.

An additional hop appears if you perform a trace 
by providing an HSRP virtual IP address as the 
source or destination in the path trace.

Workaround:

None.

CSCin35773 Map displays self loop when 
routing loop occurs.

Occasionally, when the potential first hop learnt 
by Path Analysis is not discovered successfully by 
Campus Manager, the map displays a self loop.

Workaround:

None.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
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CSCin30899 Path Analysis does not work 
when LSR Traceroute is 
disabled.

If you disable source route on routers, Path 
Analysis might not display the route occasionally.

Workaround:

None.

CSCin28223 CORBA related error message is 
logged into the log file during 
path trace.

Occasionally, during path trace, a CORBA related 
error message is logged into the ani.log file.

Workaround:

Close the client browser window and relaunch 
Path Analysis.

CSCin00624 Path trace involving HSRP 
router results in an empty If 
Index entry in the Path Analysis 
table.

The problem occurs when you run a Path trace 
which includes the IP address of an HSRP router 
in the From field of a path trace.

Workaround:

None.

CSCdw15555 Voice trace does not get Cisco 
CallManager cluster information 
if Cisco CallManager HTTPD 
shuts down.

Path Analysis Voice Trace needs to query Call 
Managers known to ANI to check what the cluster 
membership is.

This is done through a HTTP query.

As a security precaution, you might disable the 
Web Server on all cluster members except one. 
This is because Cisco CallManagers use IIS, and 
can be badly damaged by viruses such as Code 
Red and NIMDA.

However, if cluster members have Web Server 
shut off, Path Analysis cannot obtain information 
on cluster membership and cannot retrieve CDRs.

Workaround:

Turn the Web Server on the Cisco CallManager 
back on.
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CSCdw03410 Path Voice Trace does not 
consider transcoding points.

Current Campus Manager Path Analysis Voice 
Trace is valid only in the case where the two 
endpoints are IP Phones registered with the same 
Cisco CallManager cluster.

For other cases (involving transcoding), Path does 
not get correct path information. 

Examples: 

• Phone call from IP phone to POTS phone off 
H.323 gateway (e.g. 3640) 

• Phone call from one Cisco CallManager 
cluster to another.

In such a case the path would be:

a. From phone 1 to Cisco CallManager 1

b. From Cisco CallManager 1 to Cisco 
CallManager 2 through H.323 
inter-cluster trunk

c. From Cisco CallManager 2 to phone 2

• Phone call to gateway (PSTN, analog, etc.) 

• Phone call to other servers (voicemail, 
conference, etc.)

This is a very complex issue, and most likely will 
require new instrumentation from telephony 
servers, etc.

Workaround:

None.
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CSCdt42600 To and From fields may not 
function properly after selecting 
Print in Path Analysis. 

This problem is caused by Java Virtual Machine 
bug. After you select Print in Path Analysis, the 
To and From fields may not accept mouse focus, or 
focus may appear in both fields, simultaneously. 

Workaround:

Resize Java console window. If the problem 
persists, close the Path Analysis window and open 
another window. 

CSCdt42404 Trace tab displays GMT as time 
zone, although server is set to 
local time zone.

A number of Java bugs involve incorrect 
interpretation of time zones. Usually, the correct 
time zone appears if you set the local time zone to 
the appropriate three-letter abbreviation. For 
example, PST for Pacific Standard Time.

This problem is observed on Solaris clients with 
TZ environment variable set to American/Tijuana. 

Workaround:

If the TZ environment variable is instead set to 
PST8PDT, Java interprets local time zone 
correctly.

CSCdt23712 Path Analysis displays the Elvis 
module of Cisco Catalyst 6000 
devices as unknown.

Since Path Analysis depends on ANI for its tracing 
capabilities, if a device-related discovery problem 
occurs in ANI, it results in an unsuccessful trace.

Workaround:

None.

CSCdt04978 Highlighted path trace in 
Topology Services map may be 
difficult to view.

It may be difficult to view highlighted path trace 
in Topology Services map, especially if you select 
the Fit to Window view.

Workaround:

Zoom into Topology Services Map view by 
selecting 
Select All Highlighted Objects > Zoom to 
Selected.
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CSCds79693 Voice trace query results always 
appear using local time zone. 

Local time zone always appears in voice trace 
query results, even if you select GMT time zone 
when specifying call start time. 

Workaround:

None.

CSCds77461 Call Detail Records (CDR) 
query results are sometimes 
displayed after pressing Cancel.

Multiple threads are launched to query every 
Cisco CallManager for information specified in 
your CDR query. 

Since all query activities can take a second or two 
to cancel, query results sometimes continue to 
appear even after you press Cancel.

Workaround:

None.

CSCds77438 Path Analysis Map tab does not 
refresh properly.

This problem mainly occurs when running both 
the client and the server on the same machine. It 
occurs after running a large number of Path traces 
on client browser.

Workaround:

Close browser and relaunch Campus Manager.

We recommend that you run the client and server 
on different machines. 

Although this does not prevent this problem, it 
reduces its frequency because you need to run a 
large number of traces before the problem occurs.
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User Tracking Known Problems
Information displayed in a row might not reflect the most current network state. 
This is because User Tracking discovery takes information from routers and 
switches. 

Since these switches collect their information at different times, the information 
in a row reflects the state of the network or subnet at the time displayed in the Last 
Seen field.

The table below lists other User Tracking related known problems existing in 
Campus Manager.

Table 6 User Tracking Known Problems

Bug ID Summary Explanation

CSCsb17074 User Tracking does not discover 
hosts connected to devices with 
SNMPv3 credentials.

When you manage the devices Cisco 
Catalyst 3750 and Cisco Catalyst 4000 with 
SNMPv3 Credentials in Campus Manager, and if 
there are end hosts connected to these devices, the 
end hosts are not discovered and shown by User 
Tracking. 

Workaround:

None.

CSCsc71238 Purging of User Tracking 
archives and jobs fails.

When you purge User Tracking archives and jobs, 
it fails and the window aborts.

Workaround:

1. Go to Admin > Report > User Tracking > 
Purge Policy page.

2. Save the settings.

This removes all the archived reports and executed 
jobs that meet the criteria specified in the settings.
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CSCsc24107 Custom Reports filtering does 
not work for Last Seen Column.

Custom Reports in User Tracking do not display 
any entries if you query on the Last Seen column.

Workaround:

In the Last Seen column, enter the date in this 
format: yyyy/mm/dd hh:mm:ss.

See the User Tracking Online help for more 
details.

CSCsc49155 User Tracking report generator 
displays error for some Custom 
queries. 

If you run a custom query on User Tracking 
reports after remote migration, an error message 
appears.

Campus Manager 3.x allows you to create some 
queries which are not supported by CM 4.0.x. 
Hence, an error is displayed when you run the 
queries.

Workaround:

Delete the old queries created in Campus Manager 
3.x, and create new queries.

CSCsc55925 User Tracking queries with 
Cisco CallManager address fails.

This problem occurs when you have User 
Tracking queries migrated from 
Campus Manager 3.2 or Campus Manager 3.3.

If there is a Cisco CallManager address in the 
query, and you try to edit the query in 
Campus Manager 4.0.3, an error message appears.

Workaround:

None.
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CSCsc54306 User Tracking discovery spans 
more than the specified subnet.

When you start subnet discovery of user nodes, 
devices in that subnet are marked for discovery. 

Since switches support multiple VLANs, 
discovery could span more than the subnet that 
you selected. User Tracking discovers additional 
end host nodes that are not in the selected subnet.

Workaround:

Query only the required VLAN option in the 
subnet discovery window.

CSCsa30812 Job reports are not available after 
upgrading to 
Campus Manager 4.0.

Reports for the jobs that are successfully 
completed in Campus Manager 3.3 are not 
available after upgrading to Campus Manager 4.0.

This is because of the change in format of the 
Reports in Campus Manager 4.0. In earlier 
versions of Campus Manager, job results were 
stored in plain text, whereas in 
Campus Manager 4.0, the results are stored in 
serialized objects.

Workaround:

None.

CSCsa27118 User Tracking Report displays 
Port State as Static for dot1x 
authenticated ports.

User Tracking Report displays Port State as Static 
when an end host is connected to the switch port, 
which is configured for dot1x authentication.

This is because the device populates vmVlanType 
as Static for dot1x authenticated ports.

Workaround:

None
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CSCsa22740 ARP entries are not fetched for 
Cisco 3550-24 VLAN 
Interfaces.

ARP entries are not fetched for Cisco 3550-24 
VLAN Interfaces. Hence, IP Address is not 
displayed in User Tracking End Host Reports.

Workaround:

Upgrade to Cisco IOS Software Release 12.1(22).

CSCsa20659 Purge Job is created although 
you delete it from User Tracking 
Report Jobs.

In User Tracking, Purge Job is created even if you 
try to delete it from the User Tracking Report Jobs 
and Common Services JRM pages. 

It gets deleted and then recreated immediately. 
There is no functionality loss because of this.

Workaround:

None.

CSCsa14652 NAM and IDS Modules appear 
as end hosts in User Tracking.

Cisco Catalyst 6000 devices running native IOS 
service modules appear as end hosts in User 
Tracking. 

This is caused by a problem on the device. 

Workaround:

None.

CSCin00363 End host does not appear if 
obsolete device IP address is 
assigned.

If you connect a CDP device to the port and then 
add a new end host, this new end host is not learnt. 
This is because ANI is not aware of such a change. 

Workaround: 

1. Delete the specific device. 

2. Perform Data Collection for the neighboring 
devices. 

3. Perform User Tracking discovery for that 
device. 
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CSCin00181 Last Seen field gets updated for 
disconnected IP phones.

The Last Seen field in Phone Tracking 
corresponds only to the Last Seen field on Cisco 
CallManager and not to the Last Seen field on 
Network.

Workaround: 

None.

CSCec59408 Campus Manager does not query 
CISCO-PORT-SECURITY-MIB 
to verify port security 
configuration.

In User Tracking, configuring port security for a 
port makes the CAM entry static. When port 
security is configured, Campus Manager does not 
query CISCO-PORT-SECURITY-MIB.

This is because of a device specific MIB 
implementation problem. 

Workaround:

Upgrade to Cisco IOS Release 12.2(18)EW1 or 
12.2(20)EW.

CSCdw04499 End hosts are not discovered 
with Catalyst 3550 running 
Cisco IOS Release 12.1(6)EA1 
or earlier.

End hosts are not discovered with Catalyst 3550 
XL running Cisco IOS release 12.1(4)EA1 and 
Cisco IOS release 12.1(6)EA1.

Workaround:

This problem has been fixed in Cisco IOS 
release 12.1(6)EA1a. Upgrade to this version.

CSCdw04486 End hosts not discovered with 
Catalyst 2950 running a software 
release earlier than Cisco IOS 
Release 12.0(5)WC2.

End hosts not discovered with Catalyst 2950 
running a software release earlier than Cisco IOS 
Release 12.0(5)WC2.

Workaround:

This problem has been fixed in Cisco IOS 
Release 12.0(5)WC2. Upgrade to this version.
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CSCdt25525 User Tracking Main Table 
sometimes displays 
CDP-enabled devices that are 
outside the ANI discovery 
boundary.

During User Tracking discovery, User Tracking 
reads entries from the CAM table. These entries 
may include MAC addresses of devices that fall 
outside the ANI discovery boundary. 

Workaround:

None.

CSCdt06183 User Tracking Main Table may 
not display all entries that are 
displayed in the phone table.

User Tracking entries shown in the Main Table are 
discovered from network. However, User Tracking 
entries shown in the phone table are read from 
Cisco CallManager. 

If User Tracking cannot discover particular 
phones in network, entries for such phones in the 
User Tracking phone table will not have device 
and port information. 

Workaround:

Ensure that the switch to which the IP Phones are 
connected, is managed by Campus Manager.

CSCdr85384 Phone entries displayed by User 
Tracking differ from entries 
displayed by Cisco CallManager.

User Tracking phone entries acquired through 
SNMP for each Cisco CallManager may be 
different from entries in Cisco CallManager.

The Cisco CallManager database displays a 
historical record of all phones registered to Cisco 
CallManager. 

The SNMP agent retains only records of phones 
registered since the agent was started. This 
accounts for any differences.

Workaround:

None.
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Topology Services Known Problems
The table below lists the Topology Services related known problems existing in 
Campus Manager.

Table 7 Topology Services Known Problems

Bug ID Summary Explanation

CSCdr28017 Topology Services does not 
support clusters of devices.

Clusters of devices, that is, sets of devices grouped 
together under the same IP management address, 
are not supported in Topology Services

Workaround:

None.

CSCsc41956 Cannot print Topology map on 
plotters.

Topology map cannot be printed on plotters.

Workaround:

Use printer to print the Topology maps.

CSCsc20728 TDR report is not displayed 
while sorting by ports.

This problem occurs when you invoke Port 
Attributes report for a device, sort the reports 
based on ports, and then invoke TDR report. The 
report is not displayed.

Workaround:

None.

CSCsc00416 Link Attributes show same speed 
although there is a speed 
mismatch discrepancy.

Topology Services shows the same speed on both 
ends of a device, although Link Speed Mismatch 
discrepancy has been reported on the same. This 
occurs in Cisco 3500 Routers and Cisco 3640 
Series routers.

Workaround:

None.
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CSCsa37595 Cannot delete large number of 
devices from Topology Services.

An error message appears when you try to delete 
more than 100 devices from VTP Domain View in 
Topology Services.

Workaround:

We recommend that you reinitialize the database 
instead of deleting large number of devices 
through the User Interface.

CSCsa27318 Topology Services displays an 
OutOfMemoryError, while 
working with 3000 devices.

When you save the layouts and re-start topology 
map after using Topology Map tools such as zoom 
and drag, Java console displays an error: 
java.lang.OutOfMemoryError.

Workaround:

1. In the Java Plugin Control panel, go to the 
Advanced tab.

2. Add Xmx512m to the existing Java Runtime 
Parameters.

CSCsa25203 Campus Manager does not 
generate Time Domain 
Reflectometry (TDR) Report for 
Cisco 3750 and Cisco 4000 
series switches.

Campus Manager displays a blank report when 
you run TDR test on Cisco 3750 and Cisco 4000 
series switches.

This is because MIBs are not available to support 
TDR feature on these devices.

Workaround:

None.
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CSCsa22699 Inter-VLAN Routing 
configuration user interface (UI) 
does not differentiate primary 
and secondary IP addresses.

Inter-VLAN Routing configuration user interface 
shows multiple entries for the same interface when 
you configure primary and secondary IP addresses 
for SVI or sub-interfaces.

The UI does not clearly differentiate the primary 
and secondary IP addresses.

Workaround:

This problem does not occur in Cisco IOS Release 
12.1(20)E3 or later.

CSCsa18405 In PVLAN configuration, the 
secondary VLAN creation and 
association to Primary VLAN 
fail on Cisco Catalyst Operating 
System version 8.1.

In devices with Cisco Catalyst Operating System 
version 8.1, Secondary VLAN creation and 
association with Primary VLAN fail if the device 
is running on version VTP version 3.

Workaround:

Either: 

• Upgrade to Cisco Catalyst Operating System 
version 8.2.

Or

• Change VTP version to 2 and VTP mode to 
transparent.
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CSCsa12292 VLANs are not loaded for STP 
Offline Computation.

This problem occurs in Topology Services 
when you:

1. Launch STP Offline for PVST From the 
Topology Map.

2. Go to Reports > VLAN STP > 
Recommendations > STP Offline

3. Click Select Instance.

No VLANs are loaded.

Devices that do not support 
CISCO-STP-EXTENSIONS-MIB will not 
support any STP related functionality.

Workaround:

None

CSCsa11888 Channel or Trunk cannot be 
configured because of STP 
recalculation.

Campus Manager sets the channel mode to 
Desirable Non-silent on the selected devices to be 
channelled. However, STP state changes occur 
when any mode change happens.

So, if one of the two devices of the channel is an 
end-device and is only reachable through the 
to-be-channelled links, the device cannot be 
reached until the spanning-tree converges.

Workaround:

None.
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CSCsa10216 Incorrect VTP version displayed 
in VTP reports.

This problem occurs in Topology Services:

The VTP Report displays the VTP version as 1 
while the actual VTP version running on the 
device is VTP version 2. 

This issue is seen only with some of the Cisco 
Catalyst platforms such as C4506, C3750G, 
C2900.

Workaround:

None.

CSCsa04026 Link line or connection between 
two devices gets warped, if one 
device is moved.

This problem is seen in Topology services display 
map. When there is a long line between devices 
and one of the device is dragged to a different 
location on the map, a kink in the line develops 
with the link line connecting these two devices 
getting warped. 

The line appears jagged, instead of being straight.

Workaround:

To avoid this behavior, have devices closer to each 
other.

CSCin68983 Cannot configure Trunk between 
Catalyst 2900XL and Catalyst 
3500XL devices.

Trunk configuration fails between Catalyst 
2900XL and Catalyst 3548XL series switches.

This is caused by lack of MIB support.

Workaround:

None.

CSCin48159 Cannot launch IDSM from 
Service Modules launch point 
for IDSM2 card of Cisco 
Catalyst 6000 device.

From Topology Services, you cannot start IDSM 
using the Service Module launch point. This is 
because of a defect in SNMP agent of the device.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation
37
Release Notes for Campus Manager 4.0.3 on Solaris

78-17189-01



 

Known Problems
CSCin46641 Campus Manager does not 
calculate Trunk mode related 
discrepancies.

Topology Services does not report the following 
discrepancies for Cisco Catalyst 2900 series, 3500 
series, and 4000 IOS devices, in Trunk mode.

• AutoTrunk

• NoTrunk

• TrunkNegotiationEnabled

This is because of the lack of MIB support in the 
devices.

Workaround:

None.

CSCin46405 Campus Manager does not report 
Spanning Tree discrepancies for 
some devices.

Campus Manager does not report the following 
Spanning Tree discrepancies for some devices:

• BackboneFastDisabled

• UplinkFastDisabled

• BPDUGuarDisabled

• STPEnabledOnAccessPorts

This is because of lack of MIB support in the 
devices.

Workaround:

None.

CSCin46370 Trunk Negotiation Enabled 
Discrepancy Report does not 
show the Trunk mode details of 
the ports of some devices.

TrunkNegotiationEnabled Discrepancy Report 
does not show Trunk mode details of the ports on 
Cisco Catalyst 2950, Cisco Catalyst 3550, and 
Cisco Catalyst 4000 IOS devices. 

This is because of a defect in SNMP agent of the 
device.

Workaround:

None.
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CSCin45496 Campus Manager does not report 
UDLD discrepancy for Cisco 
Catalyst 2900 series switches.

Discrepancy Reports does not display UDLD 
disabled discrepancy for Cisco Catalyst 2900 
switches.

This is because of a defect in SNMP agent of the 
device.

Workaround:

None.

CSCin45070 Launch points do not work if 
http/https ports have other than 
the default value.

In Topology Services, the launch points for 
Service Modules function only if the http/https 
port numbers are set to their default value.

Launch Points must function for any valid 
http/https port number configured on the service 
modules.

Workaround:

None.

CSCin43965 Spanning Tree reports more than 
one root for a switch cloud.

Spanning Tree reports more than one root for a 
switch cloud containing Cisco 2900XL, Cisco 
3500XL, Cisco 2950, or Cisco 3550 devices, if the 
selected VLAN is not assigned to any of the ports 
in these devices.

This is because of a defect in SNMP agent of the 
devices.

Workaround:

None.
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CSCin36988 Cannot calculate utilization of 
VCs in tunnel.

This problem occurs in Topology Services when 
you:

1. Setup a tunnel between two ATM devices and 
let the devices see each other as Interim Local 
Management Interface (ILMI) neighbors on 
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel 
link.

4. Select Tools > Display VCs > Per device.

5. Click Get Info.

An error appears:

Failed to compute utilization for some 
or all rows

Workaround:

None.
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CSCin36950 Cannot view VCs in a tunnel 
from Topology Services main 
window.

This problem occurs in Topology Services when 
you:

1. Setup a tunnel between two ATM devices and 
let the devices see each other as Interim Local 
Management Interface (ILMI) neighbors on 
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel 
link.

4. Select Tools > ATM Management > Display 
VCs > Per device.

The device or port chooser does not list 
subinterfaces.

Workaround:

None.

CSCin29281 Device Attribute of Cisco 
Catalyst 6000 devices does not 
display the IP address.

Device Attribute of Cisco Catalyst 6000 devices 
does not display the IP address of WS-X6624-FXS 
module.

Instead, Device Attribute displays the IP address 
of Supervisor engine.

This is because of a defect in the SNMP agent on 
the device. For more details, see CSCin33075.

Workaround:

None.
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CSCin27895 Topology Services does not 
show VLANs as active, if the 
switch is in NULL folder under 
VTP Domain.

Topology Services > VTP Domains > NULL 
folder shows VLANs in VTP server devices as 
inactive, if the VTP Domain name is not 
configured on the device.

Topology Services displays the VLANs as inactive 
although the state of the VLAN on the switch is 
active.

Workaround:

Either: 

• Configure VTP domain name in the device 
and rediscover.

Or

• Configure VTP domain mode of the device as 
transparent and rediscover.

CSCin22459 Topology Groups membership 
update does not work as 
expected.

This problem occurs in Topology Services when 
you:

1. Launch Custom Views for a group by 
selecting Campus Manager > Topology 
Services.

2. With the Custom Views window open, delete 
a device group using Topology Group 
Administration.

Custom View does not update automatically.

Workaround:

Reopen the Custom View window.
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CSCin01977 Position of devices connected to 
Switch Cloud change after 
upgrade.

Switch clouds and fabrics represent the collection 
of LAN switches and ATM switches, respectively.

These logical entities are very specific to the 
currently discovered network. That is, if a new 
switch is discovered, you cannot uniquely identify 
a switch cloud or fabric across ANI databases.

Workaround:

None.

CSCef67937 Campus Manager does not show 
port as trunking if the port is part 
of the Channel.

This problem occurs when Cisco Catalyst 3750 
has a 12.1 EA software version.

When a port is part of channel and configured as 
trunk, Campus Manager does not display the port 
as trunking for Cisco Catalyst 3750 switches.

Workaround:

Upgrade Cisco Catalyst 3750 device to 
12.2(18)SE1 or later.

CSCeb68819 Topology Services does not 
display dual links.

When two devices with dual links are aligned 
vertically on top of each other, the co-ordinates of 
the vertices of both links become the same. 

If the devices are not vertical, Topology Map 
displays dual links. 

Workaround:

Relayout the maps using hierarchical or 
symmetrical layout, so that the devices do not 
align vertically.
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CSCea39271 Topology Services displays the 
devices connected to a UB 
Token-Ring Hub in the 
Unconnected Devices View.

CiscoWorks discovers Cisco Catalyst 4700 and 
Catalyst 4500 devices, but displays them under 
Unconnected Devices View, and not in Layer 2 
View.

Campus Manager cannot draw the map for the 
devices, as the routers are connected through a UB 
hub.

Workaround:

None.

CSCdw49136 Campus Manager cannot 
establish connection between 
ATM ELAN and Ethernet VLAN 
when you remove LEC from 
Cisco Catalyst 2900XL devices.

Initially, VLAN and ELAN are connected in 
Topology Services. When you remove LEC from 
Cisco Catalyst 2900XL devices, the connection 
between VLAN and ELAN is broken for 2900XL 
devices.

This is because of a bug on 2900XL agent devices, 
where it does not support CISCO-LEC-EXT MIB.

Workaround:

None

CSCdv41860 Fetching LANE component 
details displays an error 
AniSQLException.

In Topology Services, if you create a LANE 
component in an ATM switch (LS1010) and 
launch its view, all the Profile and Diagnosis menu 
items related to this component display the 
following error:

Internal error

Workaround:

None.
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CSCdt50619 Two devices, connected by 
multiple links, appear to be 
connected by only one link.

When two devices are connected by multiple links, 
and you rediscover either devices or links, all of 
the links are stacked on one another. 

This causes the devices to appear as if they are 
connected by only one link.

Workaround:

Perform a re-layout.

CSCdt27824 Entire list of ports in a VTP 
domain appear when you select 
certain Transparent VTP 
domains from the VLAN 
Assignment dialog box.

When similar VLAN definitions exist on a VTP 
server and transparent devices, VLAN is added 
under the parent folder and all transparent devices.

Thus, VLAN ports appear under all transparent 
devices.

Workaround:

Run Find Ports query and enter only device 
name/address to view ports for a particular device.

CSCdt18293 Visio drawing does not import 
cleanly into Microsoft Visio.

If you export a Topology map as a Visio drawing, 
it is not imported cleanly into Microsoft Visio.

Links are drawn out of place, and some incorrect 
links appear to be drawn between devices.

Workaround: 

Clean the Visio drawing manually after import.

Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation
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CSCdr11577 Virtual Circuit (VC) error chart 
is blank.

A blank chart could mean either a continuous 
polling failure or a failure caused by other 
problems. 

For example, a blank VC error chart might be 
caused by a continuous polling failure (of VC 
error related data). 

It could also be because these statistics may not be 
supported on certain image versions of the ATM 
switch, being polled.

Workaround:

None.

CSCdp88318 Link attributes are not updated 
after a change is made.

If you change link attributes, ANI Server does not 
properly discover and display the change in 
reports. 

Workaround:

To update link attributes, close and relaunch 
Topology Services.

Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation
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ANI Server Known Problems
The table below lists the ANI Server related known problems existing in 
Campus Manager.

Table 8 ANI Server Known Problems

Bug ID Summary Explanation

CSCsc43106 Device not discovered if 
SysUpTime is masked.

If the SysUpTime in masked in v1default view, 
Device Discovery does not discover the device.

Workaround:

Manually add the devices to DCR.

Or

Remove the mask in v1 default view.

CSCsa31538 Campus Manager cannot 
synchronize with Device and 
Credential Repository using 
DCR events.

When a large number of devices are updated or 
deleted from DCR, Campus Manager cannot 
synchronize with DCR using DCR events.

Workaround:

Run Data Collection from Campus Manager which 
will synchronize all devices and related information 
in DCR.

CSCsa20827 Subnet based groups are not 
deleted from Campus Manager 
Topology Groups although 
you delete them from DCR.

In DCR, if you delete all devices or all devices in a 
subnet, the corresponding subnet based groups in 
Campus Manager are not deleted immediately.

Workaround:

If you want the subnet groups to be deleted earlier 
than 20 minutes, change the property from:

SubnetPollerConfigTime = 1200000 

to a lesser value in the properties file:

NMSROOT/MDC/tomcat/webapps/campus/WEB-INF/
classes/CM_Implementation_Details.properties.
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CSCsa19337 ANI goes into Unknown State 
when you delete all devices 
from DCR.

This problem occurs in ANI when you:

1. Discover some devices by specifying seed 
devices in Campus Manager.

The DCR is updated with those devices.

2. Run data collection on those devices.

3. Invoke Topology Services. 

Devices appear in Views.

Deleting all devices from DCR will show ANI state 
and UT state as Unknown although you specify the 
seed devices in Device Discovery settings.

Workaround:

None.

CSCin74855 Device not managed in 
Campus Manager if 
management IP is not in ACS.

If a device has multiple IP addresses, Campus 
Manager automatically determines the management 
IP address of the device. 

If the management IP address is not ACS (that is, the 
device is added in ACS with a different address), this 
device is not managed in Campus Manager. Data 
collection is not done for this device.

Workaround:

IP address in ACS and management IP address in 
DCR should be the same.

CSCin33112 Cannot delete devices on a 
remote system in SSL mode 
using the command line 
interface.

The Delete Device command fails if you use it on 
a remote server in the SSL mode.

Workaround:

None.

Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation
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CSCdz11668 ANI Discovery causes 
interfaces to go down.

If you install Campus Manager on Solaris 2.8, the 
database interfaces go down shortly after beginning 
discovery. 

This causes the browsers to stop communicating 
with the CiscoWorks server. The interfaces while 
being displayed as UP in ifconfig, do not appear 
when you enter netstat -rn.

This problem is caused by a Solaris bug; Sun Alert 
ID: 48601: Solaris 8 and Solaris 9 Network Interface 
may Stop Responding to TCP Traffic.

This problem occurs in the following releases:

• Solaris 8 with patch 108528-16, or

• Solaris 8 with patch 108528-17 but without 
patch 113652-01

Workaround:

• Downgrade to kernel patch 108528-15 or earlier 
and restart the system.

Or

• Disable the ANIServer process allows 
CiscoWorks to continue functioning without 
Campus Manager applications.

The Sun bug mentioned above is resolved in Solaris 
8 with patch 108528-17 and patch 113652-01 (for 
use with patch 108528-17 only).

Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation
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CSCdw67129 Topology Services cannot 
resolve the hostname of newly 
discovered devices.

If you add the DNS entry for the devices after initial 
discovery, Topology Services cannot resolve the 
hostname of the newly discovered devices. 

The subsequent discoveries do not resolve the IP 
address to a hostname until the ANIServer reloads.

This occurs only in devices that do not have a DNS 
entry before discovery. Devices that have a DNS 
entry before ANI discovers them, do not have this 
problem.

Workaround:

Do either of the following: 

• Restart CiscoWorks Server. ANI resolves the 
IP address to a hostname after restart.

Or

1. Display the sysName in Topology Services 
(does not require a restart). 

2. Select Topology Services  > Layer 2 View > 
View > Display Labels > Show Sysname

Alternatively, you can do any of the following:

• Run Device Discovery again.

• Stop and start the ANIServer.

• If you require Campus Manager to ignore the 
cache and always look up the DNS server, add 
the following variable in the Java command line 
of the ANIServer:

Dnetworkaddress.cache.ttl=0

Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation
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CSCdt20329 ATM switches, for which 
Remote Monitoring (RMON) 
is enabled, are not highlighted 
when Show Enabled Devices 
is selected.

This problem occurs when you:

1. Select Topology Services.

2. Highlight an ATM fabric under Managed 
Domains/ATM Domains

3. Select Display View.

4. Select devices, and click Tools > RMON Data 
Collection > Show Enabled Devices

Workaround:

None.

CSCdp76410 Campus Manager client 
cannot connect to server using 
proxies.

Campus Manager does not support proxies.

Workaround:

None

CSCdm58624 Campus Manager reports VTP 
Disconnected Domain 
discrepancy when VTP 
Domain is configured across a 
LANE Trunk.

Campus Manager reports Disconnected Domain 
discrepancy even when VTP domain is configured 
across ATM cloud and the default ATM-VLAN is 
configured to carry VTP advertisements across the 
cloud.

Workaround:

Ignore the discrepancy.

CSCdm48015 An ATM trunk port is shown 
as belonging to a VLAN, even 
if there is no corresponding 
LANE client associated with 
that VLAN.

In VLAN-to-port association, all ATM ports on 
switches (except ATM switches) belonging to 
VLAN will appear.

Workaround:

Ignore ATM ports in VLAN-to-port association.

CSCdp00593 SNMP report displays wrong 
HwVersion and 
HwVersionMinor for Cisco 
LS1010 devices.

This is because the image has reached EOE.

Workaround:

Enter show hardware in the command line interface 
of Cisco LS1010 devices.

Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation
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VLAN Port Assignment Known Problems
The table below lists the VLAN Port Assignment related known problems existing 
in Campus Manager.

CSCdm91634 In Campus Manager device 
report, number of ports in a 
device’s ATM module are 
incorrectly displayed as zero.

This problem, which occurs in Catalyst 5000 devices 
running Catalyst operating system software 
release 4.3(1a), is caused by missing if Entry for 
device ATM module. 

ANI Server depends on ifEntry to determine number 
of ports in a particular module.

Workaround:

None.

Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation

Table 9 VLAN Port Assignment Known Problems

Bug ID Summary Explanation

CSCsc24275 VLAN interfaces created 
through IVR are not shown in 
the existing interface list for 
that device.

If the corresponding VLAN on which the new 
VLAN interface is being created does not already 
exist in the device, the interface is not shown in the 
list.

Workaround:

Create a VLAN in the device before you create 
VLAN interfaces.

Or 

Create interfaces for existing VLANs in the device.
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CSCin67286 Topology Services cannot 
populate PVLAN to port 
association for some ports in 
Cisco Catalyst 4000 IOS 
devices.

If the ports are inactive Topology services does not 
show PVLAN to port association in Cisco Catalyst 
4000 IOS devices.

Workaround:

Upgrade the IOS image to 12.2(25)EWA or later.

CSCdw09818 Port Attribute in VLAN Port 
Assignment displays incorrect 
information.

This problem is observed only on ports which are 
inactive. The MIB values returned by the devices 
latch on to the previous speed and duplex properties.

This is because of a defect in SNMP agent of the 
device. 

Workaround: 

None.

Table 9 VLAN Port Assignment Known Problems (continued)

Bug ID Summary Explanation
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Spanning Tree Protocol Known Problems
The table below lists the Spanning Tree Protocol related known problems existing 
in Campus Manager.

Table 10 Spanning Tree Protocol Known Problems

Bug ID Summary Explanation

CSCsa12292 VLANs not loaded for STP 
Offline Computation.

This problem occurs in STP when you:

1. Launch STP Offline for PVST From the 
Topology Map.

2. Go to Reports >VLAN STP 
Recommendations > STP Offline

3. Click Select Instance

No VLANs are loaded.

Devices that do not support 
CISCO-STP-EXTENSIONS-MIB will not support 
any STP related functionality.

Workaround:

None.

CSCsa09287 Cannot map VLANs to 
instance if the device runs 
MISTP.

In STP, if the device is running STP type as MIST, 
configuring the instance to VLAN mapping from 
STPConfiguationReport > InstanceTab will not be 
applied on the device. 

This is caused by an SNMP Agent problem.

Workaround:

None.
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Resolved Problems
The following table lists the problems resolved in Campus Manager. This section 
contains:

• Resolved Problems in Campus Manager 4.0, page 56

• Resolved Problems in Campus Manager 4.0 SP 1, page 58

• Resolved Problems in Campus Manager 4.0 SP 2, page 59

• Resolved Problems in Campus Manager 4.0.3, page 60

CSCin67279 Community suffix support is 
not available for MST on 
Cisco IOS switches.

In STP, community suffix support is not available for 
MST and MISTP on Cisco IOS switches.

Workaround:

None.

CSCed72194 MST device report does not 
report CIST root correctly.

In STP, MST device report may not report the CIST 
root properly.

This is because the dot1dStpDesignatedRootCost 
object corresponds to external root path cost. Hence 
the value of the object is 0 for all switches in the 
MST region, which contains CIST root.

Workaround:

None.

Table 10 Spanning Tree Protocol Known Problems (continued)

Bug ID Summary Explanation
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Resolved Problems in Campus Manager 4.0
The table below lists the problems resolved in Campus Manager 4.0:

Table 11  Resolved Problems in Campus Manager 4.0

Bug ID Summary Additional Information

CSCin34586 Admin user could not recreate 
top level System Defined Group 
or User Defined Group but was 
allowed to delete these groups.

This problem has been resolved.

CSCin22400 Campus Manager could not add 
deleted members, after moving 
out of step 3 in the Topology 
Groups wizard.

This problem has been resolved.

CSCdw05781 Inconsistency existed in the map 
display of some of the switches 
(non-VTP aware ones) under the 
VTP domain category. 

This problem has been resolved.

CSCds81070 IP phone entries in User 
Tracking Main Table did not 
contain subnet information.

This problem has been resolved.

CSCsa11230 When a port was part of channel 
and configured as trunk, 
Campus Manager did not display 
the port as trunking for Catalyst 
2950 Switches.

This problem has been resolved.

CSCin34249 Write to startup config did not 
work for some devices running 
Cisco IOS release 11.2 in VLAN 
Port Assignment.

This problem has been resolved.
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CSCin25679 The icon for Ether Channel was 
not available in Visio Stencil.

Campus Manager displayed an 
error message, when a map 
containing Ethernet Channel 
links was exported and opened in 
Visio.

This problem has been resolved.

CSCdz82384 Java Console displayed an error 
message when you invoked 
Topology views from Topology 
Groups.

This problem has been resolved.

CSCdw66262 Although sysName was defined, 
Campus Manager did not display 
discovered devices.

This problem has been resolved.

CSCdu10180 Campus Manager VC trace 
between devices over a VP 
tunnel resulted in an empty Trace 
Report.

This problem has been resolved.

CSCsa12341 Could not get Campus Manager 
data using DEE Servlet Interface 
Functionality. 

This problem occurred due to a 
change in DEE servlet 
command.

This problem has been resolved.

Table 11  Resolved Problems in Campus Manager 4.0 (continued)

Bug ID Summary Additional Information
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Resolved Problems in Campus Manager 4.0 SP 1
The table below lists the problems that have been fixed in 
Campus Manager 4.0 SP 1:

Table 12 Resolved Problems in Campus Manager 4.0 SP 1

Bug ID Summary Additional Information

CSCsa58186 Incremental Device Update 10.0 on 
Campus Manager 3.3 did not support 
Cisco 11000 Content Service Switch 
Series devices with image version 7.4

This problem has been resolved.

CSCsa24278 The User Tracking Upgrade utility in 
Campus Manager 3.3, which was used 
to retain or import old User Tracking 
data from earlier versions of 
Campus Manager, was not supported in 
Campus Manager 4.0.

This problem has been resolved.

CSCsa41237 Campus Manager 4.0 did not recognize 
channelized E1 and T1 serial interfaces 
on Cisco 2600XM and Cisco 3600 series 
routers.

This problem has been resolved.

CSCsa45646 The User Tracking table did not display 
hosts connected to native Cisco IOS 
switches after the User Tracking aging 
time.

This problem has been resolved.

CSCsa66218 The UTUpgrade.pl script took a long 
time to import the entries into database.

This problem has been resolved.
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Resolved Problems in Campus Manager 4.0 SP 2
The table below lists the problems that have been fixed in 
Campus Manager 4.0 SP 2:

Table 13 Customer Found Resolved Problems in Campus Manager 4.0 SP 2

Bug ID Summary Additional Information

CSCsb29266 Campus Manager 4.0 SP 1 did not 
support C7609 -IOS.

This problem has been resolved.

CSCsb26532 Campus Manager 4.0 SP 1 installed files 
with bin:bin ownership.

This problem has been resolved.

CSCsb15995 Campus Manager 4.0 did not display the 
Device Name as the Display Name.

This problem has been resolved.

CSCsb05349 Even after changing the device IP 
address in LMS 2.5, the Device 
Credentials Repository referenced the 
old IP address.

This problem has been resolved.

CSCsb02952 Campus Manager 4.0 SP 1 overwrote the 
Custom roles in ACS.

This problem has been resolved.

CSCsa97100 User Tracking reports in 
Campus Manager 4.0 showed incorrect 
entries for the Last Seen timestamps.

This problem has been resolved.

CSCsa96627 User Interface of Campus Manager did 
not get updated.

This problem has been resolved.

CSCsa83453 User Tracking did not display all entries 
for non-admin users.

This problem has been resolved.

CSCsa82974 User Tracking searches were case 
sensitive in Campus Manager 4.0 and in 
later versions.

This problem has been resolved.

CSCsa78456 Campus Manager Discovery overwrote 
the display name of the device in the 
Device Credentials Repository.

This problem has been resolved.
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Resolved Problems in Campus Manager 4.0.3
The table below lists the problems that have been fixed in Campus Manager 4.0.3:

.

CSCsa78413 Campus Manager did not display 
hostnames for devices or end hosts when 
CiscoWorks was running on 
Windows 2003, although DNS support 
was configured correctly.

This problem has been resolved.

Table 13 Customer Found Resolved Problems in Campus Manager 4.0 SP 2 (continued)

Bug ID Summary Additional Information

Table 14  Resolved Problems in Campus Manager 4.0.3

Bug ID Summary Additional Information

CSCsb22036 Duplicate records were present 
in User Tracking reports.

This problem has been resolved.

CSCsc12047 If DHCP support was enabled for 
User Tracking, User Tracking 
acquisition did not get 
completed.

This problem has been resolved.

CSCsc45080 Filtering in User Tracking 
reports did not work when there 
were large number of records.

This problem has been resolved.

CSCin68382 Tasks related to Network 
Administrator role were not 
properly reflected in ACS.

This problem occurred when a 
user in ACS server was 
associated with Network 
Administration role.

This problem has been resolved.

CSCsc05472 If device was populated in DCR 
only with hostname and not IP 
address, the device was reported 
as unknown and unreachable.

This problem has been resolved.
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CSCsb71864 Logical dialer interfaces on 
Cisco C2600 XM and 3600 
routers were not discovered.

This problem has been resolved.

CSCsb69487 User Tracking Major Acquisiton 
did not find any hosts for devices 
which did not have an IP address 
in DCR.

This problem has been resolved.

CSCsb67241 Device Discovery did not 
complete if there was no SNMP 
community string for a device, 
and multiple community strings 
was enabled.

This problem has been resolved.

CSCsb54882 SNMP timeout value was set to 
be a maximum of 60 seconds 
which is not sufficient.

SNMP timeout value does not have any restriction 
on the maximum value now.

CSCsb44430 User Tracking could not discover 
end hosts or IP phones connected 
to 802.1q trunks on Catalyst 
2900 XL and 3500 XL series 
switches.

This problem has been resolved.

CSCsb25066 When Device Discovery ran with 
some devices already in DCR 
that were out of the range 
configured in device discovery 
filter, Discovery contacted those 
devices.

This problem has been resolved.

CSCsb16465 Custom reports could not be 
maximized and viewed on a full 
page.

This problem has been resolved.

Table 14  Resolved Problems in Campus Manager 4.0.3 (continued)

Bug ID Summary Additional Information
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CSCsa91896 Duplicate Address Report in 
User Tracking took a long time 
to load.

This happened if there were a 
large number of entries in the 
User Tracking database, as well 
as a large number of duplicate 
address entries. 

This problem has been resolved.

CSCsa80409 Campus Manager Telnet and 
SSH did not support 
Windows 2003 and XP clients.

This occurred on Windows 2003 
and Windows XP clients.

This problem has been resolved.

CSCsa76928 User Tracking reported duplicate 
end host entries. 

This happened with Catalyst 
2900 XL and 3500 XL series 
devices that were configured for 
port channeling.

This problem has been resolved.

CSCsa73313 Long usernames made the User 
Tracking report columns to be 
misaligned.

This problem has been resolved.

CSCsa65685 Online help for Data Extraction 
Engine had incorrect details.

Schema for User Tracking Data, 
Switch Data, and Subnet Data 
are incorrect in the Online Help.

Online help has been updated with correct 
schemas for User Tracking Data, Switch Data, and 
Subnet Data.

Table 14  Resolved Problems in Campus Manager 4.0.3 (continued)

Bug ID Summary Additional Information
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CSCsa65131 Campus Manager Data 
Extraction Engine servlet 
interface did not work.

Online help for Data Extraction 
Engine had incorrect details on 
the servlet to be used for 
exporting User Tracking Data.

Online help has been updated to reflect the correct 
servlet details.

CSCsa65130 Online help for Data Extraction 
Engine referred to a non-existent 
logfile element.

Online help has been updated to reflect the correct 
schema.

CSCsa47864 If you had enabled SSL on 
CiscoWorks server and if you 
uninstalled Campus Manager, 
the links to Campus Manager 
application were not 
unregistered from CiscoWorks 
Homepage.

This problem has been resolved.

CSCei11601 When you added alphanumeric 
characters for SNMPv3 targets, 
all the previous details you had 
entered for SNMPv2 targets 
were deleted.

This problem has been resolved.

CSCei80254 Campus Manager 4.0 User 
Guide contained non-functional 
PERL script.

User Guide in Cisco.com has been updated with 
the correct script.

Table 14  Resolved Problems in Campus Manager 4.0.3 (continued)

Bug ID Summary Additional Information
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Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco 
also provides several ways to obtain technical assistance and other technical 
resources. These sections explain how to obtain technical information from Cisco 
Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
Cisco documentation and additional literature are available in the Product 
Documentation DVD package, which may have shipped with your product. The 
Product Documentation DVD is updated regularly and may be more current than 
printed documentation.

The Product Documentation DVD is a comprehensive library of technical product 
documentation on portable media. The DVD enables you to access multiple 
versions of hardware and software installation, configuration, and command 
guides for Cisco products and to view technical documentation in HTML. With 
the DVD, you have access to the same documentation that is found on the Cisco 
website without being connected to the Internet. Certain products also have .pdf 
versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. 
Registered Cisco.com users (Cisco direct customers) can order a Product 
Documentation DVD (product number DOC-DOCDVD=) from Cisco 
Marketplace at this URL:

http://www.cisco.com/go/marketplace/
64
Release Notes for Campus Manager 4.0.3 on Solaris

78-17189-01

http://www.cisco.com/techsupport
http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
http://www.cisco.com/go/marketplace/


 

Documentation Feedback
Ordering Documentation
Beginning June 30, 2005, registered Cisco.com users may order Cisco 
documentation at the Product Documentation Store in the Cisco Marketplace at 
this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. 
to 5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States 
and Canada, or elsewhere by calling 011 408 519-5055. You can also order 
documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or by fax at 
1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 
519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by 
completing the online feedback form that appears with the technical documents 
on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
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Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at 
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you 
can access a Product Security Incident Response Team Really Simple Syndication 
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you 
think that you might have identified a vulnerability in a Cisco product, contact 
PSIRT:

• Emergencies— security-alert@cisco.com

An emergency is either a condition in which a system is under active attack 
or a condition for which a severe and urgent security vulnerability should be 
reported. All other conditions are considered nonemergencies.

• Nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532
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Obtaining Technical Assistance
Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to 
encrypt any sensitive information that you send to Cisco. PSIRT can work from 
encrypted information that is compatible with PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use 
in your correspondence with PSIRT is the one linked in the Contact Summary 
section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical 
assistance. The Cisco Technical Support & Documentation website on Cisco.com 
features extensive online support resources. In addition, if you have a valid Cisco 
service contract, Cisco Technical Assistance Center (TAC) engineers provide 
telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online 
documents and tools for troubleshooting and resolving technical issues with Cisco 
products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website 
requires a Cisco.com user ID and password. If you have a valid service contract 
but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do
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Obtaining Technical Assistance
Note Use the Cisco Product Identification (CPI) tool to locate your product serial 
number before submitting a web or phone request for service. You can access the 
CPI tool from the Cisco Technical Support & Documentation website by clicking 
the Tools & Resources link under Documentation & Tools. Choose Cisco 
Product Identification Tool from the Alphabetical Index drop-down list, or click 
the Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree view; or for 
certain products, by copying and pasting show command output. Search results 
show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the 
information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you 
describe your situation, the TAC Service Request Tool provides recommended 
solutions. If your issue is not resolved using the recommended resources, your 
service request is assigned to a Cisco engineer. The TAC Service Request Tool is 
located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the 
Cisco TAC by telephone. (S1 or S2 service requests are those in which your 
production network is down or severely degraded.) Cisco engineers are assigned 
immediately to S1 and S2 service requests to help keep your business operations 
running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts
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Obtaining Additional Publications and Information
Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around 
the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operation are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, 
documentation, and logo merchandise. Visit Cisco Marketplace, the company 
store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com
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Obtaining Additional Publications and Information
• Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to 
help growing companies learn how they can use technology to increase 
revenue, streamline their business, and expand services. The publication 
identifies the challenges facing these companies and the technologies to help 
solve them, using real-world case studies and business strategies to help 
readers make sound technology investment decisions. You can access iQ 
Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support 
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website for 
networking professionals to share questions, suggestions, and information 
about networking products and technologies with Cisco experts and other 
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• World-class networking training is available from Cisco. You can view 
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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